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PRC Service Disclaimer 
Prentke Romich Company is not responsible for problems that may be related to new programs or software 
that have been loaded into the Pathfinder by the customer or others associated with the customer.   
 
Prentke Romich Company Service Department is not responsible for teaching customers the specifics of 
using an individual Application.  Customers should refer to an Application’s Help menu and individual 
internet sites. 
 
Prentke Romich Company Service Department is available for questions concerning Pathfinder/Windows 
CE interface problems related to the software and programs installed on the device by PRC.   
 
 
 
 
 
Pathfinder is a trademark of Prentke Romich Company. 
Minspeak is a registered trademark of Semantic Compaction systems. 
Microsoft Windows and Microsoft Word are registered trademarks of Microsoft, Inc. 
Windows CE, Microsoft ActiveSync are trademarks of Microsoft, Inc. 
Tracker is a trademark of Madentec, Inc. 
 
Information concerning CE compliance and electronic interference can be found on the 
copyright/acknowledgement pages in the Pathfinder Basics and Power User Manuals.  See these manuals 
also for complete Pathfinder operation information. 
 
 
©Prentke Romich Company 2004.  All rights reserved 
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Windows® CE Applications in the Pathfinder 
 

ÂYou can access the Windows® CE Applications by using the Pathfinder Touchscreen 
or internal Tracker™ headpointer with a manual switch.  You can also use a mouse 
by switching to Computer Mode and using the mouse movement grids on the 
Computer Overlay to access an application’s cursor. 
 

ÂThere is a summary of the different Windows CE applications at the end of this 
manual.  On the ActivSync CD that came with the Pathfinder, you can find links to 
manuals for some of the CE Applications.   
 
 
 

FIRST TIME USE 
 
Release the Pathfinder from Shipping Mode: 
 

On the left front of the case:  press down and hold the  and  buttons. 
Release the buttons.  Pathfinder comes on. You will eventually see the Pathfinder Display 
Screen and the Activity row. 
 
This is the regular Pathfinder Workspace. 
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ANYTIME USE 
 
Viewing the Application Workspace:  Hide/Show Pathfinder 
 
When your Pathfinder first comes on, the regular Pathfinder workspace is running in the 
foreground.  You see the Activity Row and Display Screen.  
 

 
 
 
On your overlay, make sure you are in Minspeak Mode, then select    

 (TOOLBOX + THUMBS DOWN).   
 
 

 
 
Now you see the Windows CE Applications screen.  In the System Tray at the bottom of 
the screen you can see the Windows Start menu and the Pathfinder listed.  This means 
you are now running the Applications workspace. The Pathfinder workspace is in the 
background.  When you have an Application open, you will see it instead of this screen. 

To return to the Pathfinder workspace, select  (TOOLBOX + THUMBS UP) 
again, or select the Pathfinder option at the bottom of the touch screen.   

  and   allow you to toggle between the Pathfinder and an open 
CE application. 
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Special Pathfinder Tools 
 
 
 

The following sequences are new insertable Tools to use with the CE Applications. 
They have been stored on your device. 
 
 

ICON 1 ICON 2 
 

FUNCTION 
 

 

 

 

 

 
Brings your Pathfinder screen back so you can communicate normally. 
 

Stored as:  <SHOW-PATHFINDER> 
 

 

 

 

 

 
Hides your Pathfinder screen so you can see the CE applications. 
 

Stored as:  <HIDE-PATHFINDER> 
 

 

 

 

 

 
Hides the Text Area of your Pathfinder screen so you can see through 

to the CE application behind. ÂIf the Activity Row or Word 
Prediction are open in the Pathfinder, they will remain visible in an 
Application when you select this sequence. 
 

Stored as:  <HIDE-TEXT-AREA> 
 

 

 

 

 

 
Allows you to toggle your Activity Row On and Off – useful 
sometimes when you want to see the whole screen of a CE application. 
 

Stored as:  <ACTIVITY-MENU>1 OK 
 

 

 

 

 

 
Allows you to turn word prediction on and off. 
 

Stored as:  <WORD-PREDICTION-MENU>1 OK 
 

 
Use these sequences when you are working with CE Applications.   
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Using a Mouse and Computer Mode to access CE Applications 
�
ÂMake sure Output Method is set to RS232 and Output is set to ON in the OUTPUT 

MENU. (These settings should be the default settings that were set up at the factory.) 
 
To use mouse movements, you must be in Computer Mode.  
 

Select   (TOOLS + COMPUTER) to go to Computer Mode.  Notice the LED 
lights up next to the computer icon on the right front of the Pathfinder case.   
 
Place the Computer Overlay on your Pathfinder.  This special overlay is shipped with the 
Pathfinder. 
 
Activate the middle key in the smaller grid, outlined in purple. You should see a cursor 
on the display screen.  This grid allows you to make large cursor movements. 
 
The green and yellow grid on the overlay allows you to make smaller movements 

ÂSee your Pathfinder Power Tools manual for complete information about using 
Computer Mode and the Computer Overlay. 

You can return to Minspeak mode by activating =, (the SPELL/MIN key). 
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Opening and Using CE Applications 
 

ÂYou cannot speak while you are in an Application.  You must return to the 
Pathfinder workspace to speak.   
 
 
Below are pre-programmed sequences that will open Applications, help you navigate 
within an application or take you to the Computer Access Menu.. 
 
 

ICON 1 ICON 2 
 

FUNCTION 
 

  

 

Opens the PDF Viewer software – allows you to see PDF files. 
 

  

 

Opens the Windows® Media Player. 
 

  

 

Opens the Pocket MBA Calculator – and advanced function business 
calculator. 
 

  

 

Opens the Image Viewer software. 
 

  

 

Opens Windows® Pocket Paint program. 
 

 
 

Opens Windows® SpreadCE program. 
 

  

 

Opens the Pocket On-Schedule time manager program – keep a 
calendar, schedule appointments, write a journal, build a contact list 
etc. 
 

  

 

Opens a Wordpad document. 
 

  

 

Opens the Windows® CE Task Manager – lets you to move between 
open CE applications. 

  

 

Closes the active, running CE application. 
 

  

 

Opens the first menu in the far left of the Menu Bar in any CE 
application – typically the File Menu.  Use the arrow keys on your 
keyboard to step through the other menus. 
 

  

 

Takes you to the Computer Access Option in the USER AREA MENU. 
You can check your settings for working with a computer. 
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Select   to open WordPad.  "Pathfinder" is in the Menu bar at the bottom of 
your screen and the WordPad Application is active. 
 
You should see this: 
 

 
 
If you don’t see the Activity Row you may have accidentally turned it Off.  Select  
 

.  This will bring up the Activity Row.   
 

Selecting again will hide the Activity Row. 
 
There is a WordPad formatting Activity you can use with WordPad.   
Select the CHOOSE ACTIVITY key on your overlay.   
 
You see: 
 

 
 
Select the CE WordPad Activity. 
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Now the basic text formatting tools are available for you to use. 
 
 

Select .  The Activity Row is hidden. 
 
 

 
 
Notice the top menu bar and the bottom system tray on the application.  The top bar 
contains all the normal Microsoft Word menus and options.   
 
The system tray contains the normal Windows Start menu, the Pathfinder option, the 
name of the open document and the time. In the far right corner there is the Desktop icon.  
This will take you to the CE Applications desktop (Pathfinder logo screen). 
 
With WordPad open, make sure you are in Minspeak® or Spell Mode.  In Minspeak 
Mode you can select sequences to add as text in your document.  In Spell Mode you can 
type in text.   
 
Select sequences or type some text into WordPad.  When you are in Minspeak or Spell 
modes, any text you input into the Application will also be generated in the Pathfinder 
workspace.  
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To see the text in the Pathfinder, select   on your overlay or select 
"Pathfinder" from the System Tray.   
 
 

 
Word Prediction is open in this graphic of the Pathfinder workspace. 
 
 

To return to your application, make sure you are in Minspeak.  Select  � f you 
want to keep your Activity Row or Word Prediction visible.   

Select   if you no longer want the Activity Row or Word Prediction visible 
when you return to your CE Application. 
 

ÂIf you open a Notebook in the Pathfinder, then open WordPad, any text you type in 
WordPad will also be entered into the open Notebook.  You can save your work in the 
Notebook as you normally would. 
 

If you are working in an Application, but do not have a Notebook open, you can copy 
your Application work, go to the Pathfinder and open a Notebook, then paste your work 
into the Notebook. 
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When you have finished looking at WordPad, close the application by one of these 
methods:   
 

• Select the X button in the upper right corner of the menu bar 
 
 

• Select  to open the File menu in the upper left corner. Use the ARROW 
KEYS on your overlay to select Close. Then select the OK key. 

 
 

• Select on your overlay.  This closes the current Application. 
 
Do not save the document now.  We will discuss Saving your Work below. 
 
 
Open other Applications and familiarize yourself with them.  The Media Player 
Application also has its own Activity.  Select it from the Activity Row just like you did 
the WordPad formatting Activity. 
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Saving Your Work 
 
You will want to save your Application work periodically.  We have included a Secure 
Digital card to use with your Pathfinder. Save your individual file documents, images 
and MP3 files onto the Secure Digital card, as well as any CE System Backups you may 
do.  Using this card means that you have an independent copy of your work that is not 
tied to the Pathfinder’s system software.   
 
 
 

 
 
The Secure Digital card is already in place in its slot on the top of the Pathfinder. 

�
�
ÂWe recommend that you leave the Secure Digital card in the Pathfinder.  Do not 
remove and re-insert it unless absolutely necessary.  
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Save Work to the Secure Digital Card 
 
 
Open an Application, such as WordPad. 
Add some text to the document. 

Open the File menu in the upper left corner.  You can use , the touchscreen, or 

Computer Mode and the cursor.  To use the cursor select  to switch to 
Computer Mode 
 
Select Save As.   
 
You see: 

 

ÂIf your Activity Row or Word Prediction is in the way, select  to see the 
whole window. 
 
Double-click on SD Card.lnk 
 
You see: 
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You can do two things: 
 
• You can name and save the document as an individual file on the SD Card  
 

• You can create a new folder, name it something like, Documents, and then name and 
save the current document into that folder.   

 
If you want to create a folder where you can store all your saved documents:  

select the New Folder icon ,  
 

 
 

Name the folder and select OK in the top right of the menu bar. Or select the OK key on 
your overlay. 
 

 
 

The Pathfinder opens the folder. 
Type in a name for the document you want to save and select OK. 
 

ÂWhen you first save anything from a new Application, you might want to create a folder for 
that application.  For example, you could create folders for WAV files and MP3 files.   
 
If you do not want to create a folder, just type in a name for the document you want to 
save and select OK. 
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Save your Work using a USB Flash Drive 
 

If you have a USB Flash Drive you can also use it to save your work.  Flash Drives are 
easy to plug into the Pathfinder and into most computers.  The USB connectors are 
usually on the front of the computer.  Flash drives make moving information to-and-from 
your computer and Pathfinder fairly easy.    
 

 
Plug the Flash Drive into the Rectangular USB port on the left side of the Pathfinder.   
 

 
 
In an open application, open the File menu in the upper left corner of the screen.  Select 

, the touchscreen, or computer mode and the cursor.  To use the cursor select 

 to switch to Computer Mode 
 
Select Save As.   
 

 
 
Select the Up One File Folder icon. 
 
Select the Up One File Folder icon again. 
You see: 
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. 

Select USB Storage from the Save As screen. 
 
 

 
 
Name the document and select OK. 
 
Now you can remove the Flash Drive from the Pathfinder and plug it into your computer.   
Open Explorer (or its Mac equivalent) and find your Removable Disk drive. Open it.  
You see any documents, images, etc., that you saved to this drive.  You can now save 
them to your computer, if you wish. 
 
 
Removing the Flash Drive from your Computer: 
 

In order to remove a Flash Drive from your computer, you may have to tell the computer 
to stop running the drive.  Look for a new small icon in the lower right side of your 
system tray.  Double click on this icon.  Follow the directions to disconnect your Flash 
Drive.   
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Backup the Entire Pathfinder CE System 
 
If your Pathfinder ever loses power—for example, if the batteries die or the battery pack 
is disconnected, or if you lock up the device so that you have to do a 4-button re-set, you 
will want to be able to re-install a backup of the CE Applications you have been using.   
 
You can perform a System Backup and save your entire Pathfinder CE system on the 
Secure Digital card or a USB Flash Drive.  This means that anything that was in the 
Pathfinder CE system at the time of the backup can be loaded into your Pathfinder if you 
ever have to re-boot the entire system.   
 

ÂAs long as you are regularly backing up your work to the Secure Digital card you 
should not need to do a system backup very often.  There are two exceptions to this, 
however.   
 

• If you download any new applications to your Pathfinder, you will want to do a 
system backup so the new applications will be re-loaded if you ever have to re-
boot your Pathfinder.   

 
• If you make changes and additions to the Pocket On-Scheduler, you will want to 

back them up using a System Backup because there are other files in the 
Pathfinder system that the Scheduler needs in order for you to use it.  These files 
can only be backed up with a complete System Backup.  

 

Â A System Backup backs up the Pathfinder CE system. If you want to backup the 
Pathfinder memory including User Areas and vocabulary, perform an MTI.   
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To Backup the Pathfinder CE System to the Secure Digital 
Card: 
 

ÂA backup can take 4-5 minutes. If you have added a lot of new things to the CE 
system, it will take longer.  Schedule your time accordingly.   
 
 
 
On the Application Screen or in the Application Activity, open the Start menu in the 
lower left corner of the screen.  Select Programs.  Select BackupRestore. 
 
 

 
 
 

 
 

Select OK. 
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Select Backup System, and then Backup.   
 
The Pathfinder warns you that it is going to close any open documents.  Select OK. 
 

 
 
Enter a name for the backup, then select OK. 
 
The back up is saved to the Secure Digital card. 
 

ÂA regular backup can take 4-5 minutes. If you have added a lot of things to the CE 
system, it may take longer.  Schedule your time accordingly.  Be patient. 
 
When the backup is completed, select OK and Exit. 
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If you ever need to Restore the CE System, use your latest 
Backup 
 
 
Follow the steps to begin a backup, i.e., select Start Menu, Programs, BackupRestore. 
 
When you see 
 

 
 
Select Restore System, and then Restore. 
 
When the screen asks you to Select a Backup Set, select the Backup you want to use 
from your saved backups. Then select OK. 
 

ÂRestoring is much faster than backing up. 
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Using ActiveSync:  Transfer your Pathfinder Work to a 
Computer or Download Computer Files to your Pathfinder 
�
ÂActiveSync requires that you have a USB port on your computer.   
 
 
Install ActiveSync on your Computer: 
 
When you received your Pathfinder, you also received two CDs.  Find the CD titled CE 
Application Support.  Insert this CD in the CD drive on your computer. 
 
Select the ActiveSync link in the left column. 
 
You see: 

 
 
Select SAVE.  This puts a shortcut to ActiveSync on your desktop. (Your screen may 
look different from the one above.) 
 
Close the CD program and go to your computer desktop. 
 
Double-click on the MSASYNC.exe icon on your desktop 
 
You see: 
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Select Next to continue. 

�
Select Next if you want the file stored in this folder;  select Change if you want to select 
another folder. 
 
The files will be installed on your computer. 
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You must connect your Pathfinder to your computer using the USB cable that came 
with your Pathfinder.  The USB cable is a long thin cable with a small square plug on one 
end and a small rectangular plug on the other.  
 
Turn your Pathfinder ON. 
 

 
 
Connect the small square plug at one end of the USB cable to the square USB port on the 
left side your Pathfinder. 
 
Connect the other end of the cable to the USB port on your computer. The USB 
connector is generally on the front of most computers. 
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The default is YES.  You want a partnership, so leave this box checked. 
 
 

 
 

Select Next without checking any boxes. 
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Select Finish. 
 
 
 

 
 

You will see this screen.  Your Pathfinder files are now available on your computer. 
 

Open the Options menu at the top of this screen.. 
 

Select the Rules tab. 
 



 

Using Pathfinder with Windows CE Applications 
26 

 

 
 
Uncheck the Convert Files box.  Select OK until you exit the Options menu. 
 

ÂNote:  if you ever want to transfer Word documents that contain pictures, you 
should place a check in this box. However, the majority of the time you will want this 
box unchecked. 
 
 
Now, open the Explore menu. 
 

 
 
 
 
 

Uncheck this box 
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You see: 
 

 
 
This folder contains all the Pathfinder files.  Open the SD Card folder 
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Your card may have more, or less, on it than the one in this picture. 
 
If you created a Documents folder when you first saved a WordPad document, you will 
see it here.  If you created other folders for different Applications, you will see them 
listed here.  
 
You can use these folders to transfer documents, wav files and/or MP3s from your 
computer to your Pathfinder, or to transfer documents, etc., from the Pathfinder to your 
computer.  You may want more folders for different things, eventually.  You can create 
new folders here by opening the File menu and selecting New Folder.  
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Save Pathfinder Files on your Computer:  An Example 
 
Perhaps you have some documents from your Pathfinder that you would like to have on 
your computer where they may be easier to work with. 
 
With ActiveSync connected, open the Explore menu.  Open the SD Card folder.  Open 
your Documents folder.  Now drag the documents you want onto your computer desktop.  
(You can also open Windows Explorer, select Mobile Device, then follow the steps 
above.)  You can save the file wherever you want on your computer.  You can also copy 
the whole folder to your desktop. 
 
 
 
 

Transfer Wav Files to your Pathfinder:  An Example 
 
Let’s say you have some wav files saved on your computer that you would like to have in 
your Pathfinder.   
 
Using Explorer, find the files you want.  Open the drive that is listed as Mobile Device.  
Open the SD Card folder.  Drag the wav files into the Wav Files folder, if you have 
created one or just drag them onto the SD Card screen.  Active Sync automatically 
transfers them to your Pathfinder. 

ÂYou could also save files to your desktop.  Then open the Explore menu in 
ActiveSync. Open the SD Card Folder and drag the files from your desktop into the 
Wav Files folder or onto the SD Card screen.   
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Miscellaneous Information that is Good to Know 
 
 
Tell the Pathfinder to direct your keystrokes and mouse movements to 
an External Computer.   
 

When the Pathfinder is shipped to you, the device is automatically set to work the CE 
Applications.  However, if you want to do work on an external computer, you will need 
to change the Computer Access Menu options to indicate you are using an external 
computer.   
 

For quick access to this menu, select   .  This sequence takes you to the USER 
AREA MENU, then automatically opens the Computer Access Menu option. 
 
 
 
 
 

 
 
Set Host Computer Type to IBM, Newer Mac or Older Mac, depending on the type of 
computer you are using.  
 
Select OK.  Select OK. 
 
If your Pathfinder does not work with a computer after changing the above setting, go to 
the OUTPUT MENU and make sure the Output Method option is set to RS232 and the 
Output option is set to ON. 
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Create a Shortcut to an Application 
 
The Pathfinder has been set up so that you can open some of the CE Applications that 
came with the device.  On your overlay, select the icon sequence that opens the 
Application you want to use.   
 

Eventually you may want to run other Applications that are included with the Pathfinder 
such as PowerPoint Viewer. 
 
 You can create your own icon sequence shortcut to open a new Application by using the 
RUN PROGRAM tool. 
 

Go to the TOOLBOX. 
Select STORE CORE. 
Select an icon sequence. 
Select Spell Text for Message. 
Select INSERT TOOL 
Use MORE ITEMS or type "R" until you see RUN PROGRAM. 
Select RUN PROGRAM. 
 

You see: 
 

 
 
Go to the folder where you stored the new Application. 
Double-click on the Application you want to store. 
You should see <RUN PROGRAM> and the Application you selected as the stored 
message. 
Select OK. 
Select OK. 
 
 

If the Pathfinder Loses Power 
 

If the Pathfinder’s batteries die, if the battery pack is disconnected, or if you lock up the 
device so that you have to do a 4-button re-set, the Pathfinder will re-boot from the 
System Storage Card.  During the re-boot process, you will see a screen asking if you 
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want to re-load Applications.  Select YES.  All of the applications will be loaded and 
ready to use again. 
 
 

Macros used to open and Navigate Applications   
 
On the following pages you will find the macros that were used for opening and 
navigating Applications.  These may be helpful to use as guidelines if you want to create 
an Activity Row for an Application or other functions you might like to use with the 
applications. 
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Macros used to open and Navigate Applications   
 
 

ICON 1 ICON 2 FUNCTION and MACRO 
 

  

Opens the FIRST MENU of any CE application – typically the File Menu. 
Use the arrow keys on your keyboard to step through the other menus. 
 
<MOUSE-SET(MENU 1)> 
 

  

Opens the Windows® CE Task Manager – lets you to move between open 
CE applications. 
 
<HIDE-PATHFINDER><SERIAL-MARKER> �FRPELQH�DOW�WDE� 
 

  

Opens the PDF Viewer software – allows you to see PDF files. 
 
<RUN-PROGRAM>(“\Windows\pdfviewer.exe”) 
 

  

Opens the Windows® Media Player. 
 
<RUN-PROGRAM>(“\Windows\ceplayer.exe”) 
 

  

Opens the Pocket MBA Calculator – and advanced function business 
calculator. 
 
<RUN-PROGRAM>(“\Program Files\Pocket MBA-Calc\pmba.exe”)<HIDE-
PATHFINDER> 
 

  

Opens Windows® Pocket Paint program. 
 
<RUN-PROGRAM>(“\Windows\PPAINT.EXE”) 
 

  

Closes the active running CE application. 
 
<MOUSE-SET(MENU 1)><SERIAL-MARKER> HQWHU� 
 

  

Opens the Pocket On-Schedule time manager program – keep a calendar, 
schedule appointments, write a journal, build a contact list etc. 
 
<RUN-PROGRAM>(“\Program Files\Pocket On-Schedule\hpcOnsched.exe”) 
<HIDE-PATHFINDER> 
 

  

Opens a Wordpad document. 
 
<RUN-PROGRAM>(“\Windows\pword.exe”) 
 

  

Opens the SpreadCE© spreadsheet program. 
 
<RUN-PROGRAM>(“\Windows\SpreadCE.exe”) 
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Macros used for WordPad Commands 
 
 
Opening Application 
 

ICON 1 ICON 2 
 

FUNCTION 
 

 

 

 

 

 
Opens the Wordpad program with a new document. 
 

<RUN-PROGRAM>("\Windows\pword.exe") 
 

 
 
WordPad Activity Row 
 

      
  

BOLD ITALICS UNDERLINE UNDO FONT  TAB   

 
 

 KEY CONTENTS 
 

 
<SERIAL-MARKER> �FRPELQH�FWUO�E�6(7-ACTIVITY(CEwordpad)> 

 
<SERIAL-MARKER> �FRPELQH�FWUO�L�6(7-ACTIVITY(CEwordpad)> 

 
<SERIAL-MARKER> �FRPELQH�FWUO�X�6(7-ACTIVITY(CEwordpad)> 

 
<SERIAL-MARKER> �FRPELQH�FWUO�]�6(7-ACTIVITY(CEwordpad)> 

 
<SERIAL-MARKER> ,combine,alt.o,f<SET-ACTIVITY(CEwordpad)> 

 
<SERIAL-MARKER> WDE���6(7-ACTIVITY(CEwordpad)> 
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The CE Applications in the Pathfinder 
 
Below are short descriptions of the Applications in your Pathfinder.  Help Menus are 
available within the Applications.   
 

ÂImportant Note: This table lists applications that do not have icon sequence 
short cuts already created for them.  If you would like to create a shortcut for any of these 
programs, use the RUN PROGRAM instructions on page XX. When you are asked to 
Select a Program, select the Windows folder.  Choose the .exe file that you want.   
 
 
 
 
• Microsoft Excel Viewer 
• Microsoft Image Viewer 
• Microsoft PDF Viewer 
• Microsoft PowerPoint Viewer 
• Microsoft Word Viewer 
 

 
Allows you to view files created for 
various Microsoft programs. You cannot 
edit these files. 

 
• Backup/Restore 
 

 
Creates a backup file on the Secure digital 
card for the Pathfinder CE applications 
software.  
 

 
• FreeCell 
• Solitaire 
 

 
Games. 

 
• Windows Explorer 
 

 
Allows copying/deleting/moving of files 
within the CE software. 
 

 
• Terminal 
 

 
Advanced use: allows device to be used as 
a terminal emulator – unlikely to be used. 
 

 
• Command Prompt 

 
Advanced use: access to the CE command 
prompt – unlikely to be used. 
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The CE Applications in the Pathfinder 
 

ÂIcon Sequence shortcuts have been created for the following Applications.  See 
the chart on page XX for the sequences.   
 
 
 
 
• Microsoft WordPad 
 

 
Word processing software based on 
Microsoft Word. 
 

 
• SpreadCE 
 

 
Spreadsheet software. Files can be saved in 
a generic format so they can be read by 
Microsoft Excel. 
 

 
• Pocket On-Schedule 
 

 
Scheduler. Includes Contacts, Journal, Task 
Manager, and Notes facilities. 
 

 
• Pocket MBA-Calc 
 

 
Calculator with business and scientific 
functions. 
 

 
• MediaPlayer 
 

 
Plays WAV and MP3 files, along with 
other media file types. 
 

 
• PPAINT 
 

 
Simple paint program for creating and 
editing BMP format images. 
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Synchronize Pocket On-Schedule with Microsoft® Outlook 
 
 
 

Important Notes: 
 
ÂYou must have the full Outlook 2000 or newer version installed on your computer in 
order to synchronize Outlook and Pocket On-Schedule.  Outlook Express will not 
synchronize. 
 

ÂActivSync must be installed on your computer. If you have not previously installed 
ActivSync on your computer, follow the directions on pages 21 through the top of page 
26. Then continue with these instructions. 
 

ÂTo synchronize with Outlook, make sure the Pocket On-Schedule application on 
the Pathfinder is closed.  If On-Schedule is open, synchronization will not work.   
 

 
 

Install the On-Schedule Sync Program 
 
• Find the CE Application Support CD that came with your Pathfinder. Insert it into 

the CD drive of your computer. 
 
• Select On-Schedule Sync. 
 
Follow the installation directions on your computer screen. 
 

ÂThis installation adds an On Schedule Sync menu to your Outlook menu bar.  It does 
not add an icon to your desktop. 
 
• Connect the ActivSync cable that came with your Pathfinder to the USB port on your 

computer and to the rectangular USB port on the left side of your Pathfinder. 
 
• You should see an information box that says something similar to, "New device 

detected. Do you want to create a partnership?"  Select YES. 
 
• The first time you set up this program you will be asked whether you want to 

synchronize your computer to the Pathfinder or the Pathfinder to the computer.  You 
will probably want to select the option where your most up-to-date information is.  
After the first synchronization, the program will automatically synchronize the two 
devices so that they match.   
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• In Outlook, select the Calendar or one of the other scheduling options.  Add 
something new to the Calendar (or whatever option you selected).   

 
• Open the On-Schedule Sync menu in the Outlook Menu Bar.  Select Synchronize 

Now. 
• Open the Pocket On-Schedule application on the Pathfinder.  Look through the 

options and you will see that your appointments, contacts, etc., match those in your 
Outlook program.   

 
In Outlook, open the On-Schedule Sync menu. 
 
Select On-Schedule Sync Manager. 
 
Select the Options tab. 
 
Place a check in the box next to the first statement: "Automatically synchronize upon 
connecting with handheld device."  This means that each time you connect your 
Pathfinder and computer, On-Schedule Sync will automatically synchronize Outlook and 
the Pathfinder On-Schedule application so that they each contain the latest information.   
 
If, after you have connected and updated, you make changes to the On-Schedule 
application or to an item in Outlook, you will have to select Synchronize Now from the 
On-Schedule Sync menu to update with the new information. 
 

ÂIn the On-Schedule Sync Manager, under the tab for E-Mail, the default selection 
automatically downloads your Outlook e-mail into the On-Schedule application in the 

Pathfinder.  If you uncheck this box, your e-mails will not be downloaded. ÂThis option 
only works if Outlook is set up as your e-mail program.   
 
From now on, all you have to do to synchronize your Outlook program and the On-
Schedule application in the Pathfinder is to turn both your computer and your Pathfinder 
On and connect them with the ActivSync cable that came with your Pathfinder. 
 
 
 


